
The  Arduino  Mega  2560  is  a  microcontroller  board  based  on  the  ATmega2560 
(datasheet). It has 54 digital input/output pins (of which 14 can be used as PWM outputs), 
16 analog inputs, 4  UARTs (hardware serial ports), a 16  MHz crystal oscillator, a USB 
connection,  a  power  jack,  an ICSP header,  and a reset  button.  It  contains everything  
needed to support the microcontroller; simply connect it to a computer with a USB cable or 
power it with a AC-to-DC adapter or battery to get started. The Mega is compatible with 
most shields designed for the Arduino Duemilanove or Diecimila. 



EAGLE files:    arduino-mega2560-reference-design.zip        Schematic: arduino-mega2560-schematic.pdf 

Microcontroller ATmega2560
Operating Voltage 5V
Input Voltage (recommended) 7-12V
Input Voltage (limits) 6-20V
Digital I/O Pins 54 (of which 14 provide PWM output)
Analog Input Pins 16
DC Current per I/O Pin 40 mA
DC Current for 3.3V Pin 50 mA
Flash Memory 256 KB of which 8 KB used by bootloader
SRAM 8 KB
EEPROM 4 KB
Clock Speed 16 MHz



The Arduino Mega2560 can be powered via the USB connection or with an external power supply. The power source is  
selected automatically. External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or battery. The 
adapter can be connected by plugging a 2.1mm center-positive plug into the board's power jack. Leads from a battery  
can be inserted in the Gnd and Vin pin headers of the POWER connector. 

The board can operate on an external supply of 6 to 20 volts. If supplied with less than 7V, however, the 5V pin may 
supply less than five volts and the board may be unstable. If using more than 12V, the voltage regulator may overheat  
and damage the board. The recommended range is 7 to 12 volts. 

The Mega2560 differs from all preceding boards in that it does not use the FTDI USB-to-serial driver chip. Instead, it  
features the Atmega8U2 programmed as a USB-to-serial converter. 

The power pins are as follows: 

• VIN. The input voltage to the Arduino board when it's using an external power source (as opposed to 5 volts 
from the USB connection or other regulated power source). You can supply voltage through this pin, or,  if 
supplying voltage via the power jack, access it through this pin. 

• 5V. The regulated power supply used to power the microcontroller and other components on the board. This 
can come either from VIN via an on-board regulator, or be supplied by USB or another regulated 5V supply. 

• 3V3. A 3.3 volt supply generated by the on-board regulator. Maximum current draw is 50 mA. 
• GND. Ground pins. 

The ATmega2560 has 256 KB of flash memory for storing code (of which 8 KB is used for the bootloader), 8 KB of 
SRAM and 4 KB of EEPROM (which can be read and written with the EEPROM library). 

Each of  the  54  digital  pins  on  the  Mega can  be  used as  an  input  or  output,  using  pinMode(),  digitalWrite(),  and 
digitalRead() functions. They operate at 5 volts. Each pin can provide or receive a maximum of 40 mA and has an 
internal pull-up resistor (disconnected by default) of 20-50 kOhms. In addition, some pins have specialized functions: 

• Serial: 0 (RX) and 1 (TX); Serial 1: 19 (RX) and 18 (TX); Serial 2: 17 (RX) and 16 (TX); Serial 3: 15 (RX) and 
14 (TX). Used to receive (RX) and transmit (TX) TTL serial data.  Pins 0 and 1 are also connected to the 
corresponding pins of the ATmega8U2 USB-to-TTL Serial chip . 

• External Interrupts: 2 (interrupt 0), 3 (interrupt 1), 18 (interrupt 5), 19 (interrupt 4), 20 (interrupt 3), and 21  
(interrupt 2). These pins can be configured to trigger an interrupt on a low value, a rising or falling edge, or a  
change in value. See the attachInterrupt() function for details. 

• PWM: 0 to 13. Provide 8-bit PWM output with the analogWrite() function. 
• SPI:  50 (MISO),  51 (MOSI),  52 (SCK),  53 (SS). These pins support  SPI  communication,  which,  although 

provided by the underlying hardware, is not currently included in the Arduino language. The SPI pins are also 
broken out on the ICSP header, which is physically compatible with the Duemilanove and Diecimila. 

• LED: 13. There is a built-in LED connected to digital pin 13. When the pin is HIGH value, the LED is on, when  
the pin is LOW, it's off. 

• I2C: 20 (SDA) and 21 (SCL). Support I2C (TWI) communication using the Wire library (documentation on the 
Wiring website). Note that these pins are not in the same location as the I2C pins on the Duemilanove.

The Mega2560 has 16 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 different values). By default 
they measure from ground to 5 volts, though is it possible to change the upper end of their range using the AREF pin and 
analogReference() function. 

There are a couple of other pins on the board:

• AREF. Reference voltage for the analog inputs. Used with analogReference(). 
• Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset button to shields which 

block the one on the board. 



The Arduino Mega2560 has a number of facilities for communicating with a computer, another Arduino, or 
other microcontrollers. The ATmega2560 provides four hardware UARTs for TTL (5V) serial communication.  
An ATmega8U2 on the board channels one of these over USB and provides a virtual com port to software on  
the computer (Windows machines will need a .inf file, but OSX and Linux machines will recognize the board 
as a COM port automatically. The Arduino software includes a serial monitor which allows simple textual 
data to be sent to and from the board. The RX and TX LEDs on the board will flash when data is being  
transmitted via the ATmega8U2 chip and USB connection to the computer (but not for serial communication 
on pins 0 and 1). 

A SoftwareSerial library allows for serial communication on any of the Mega's digital pins. 

The ATmega2560 also supports I2C (TWI) and SPI communication. The Arduino software includes a Wire 
library to simplify use of the I2C bus; see the documentation on the Wiring website for details. To use the SPI 
communication, please see the ATmega2560 datasheet. 

The Arduino Mega2560 can be programmed with the Arduino software (download). For details,  see the 
reference and tutorials. 

The Atmega2560 on the Arduino Mega comes preburned with a bootloader that allows you to upload new 
code to it without the use of an external hardware programmer. It communicates using the original STK500 
protocol (reference, C header files). 

You can also bypass the bootloader and program the microcontroller through the ICSP (In-Circuit Serial 
Programming) header; see these instructions for details. 



Rather then requiring a physical  press of  the reset  button before an upload,  the Arduino Mega2560 is  
designed in a way that  allows it  to be reset by software running on a connected computer.  One of  the 
hardware flow control lines (DTR) of the ATmega8U2 is connected to the reset line of the ATmega2560 via a  
100 nanofarad capacitor. When this line is asserted (taken low), the reset line drops long enough to reset the 
chip. The Arduino software uses this capability to allow you to upload code by simply pressing the upload 
button in the Arduino environment.  This  means that  the bootloader can have a shorter  timeout,  as the 
lowering of DTR can be well-coordinated with the start of the upload. 

This setup has other implications. When the Mega2560 is connected to either a computer running Mac OS X 
or Linux, it resets each time a connection is made to it from software (via USB). For the following half-second 
or so, the bootloader is running on the Mega2560. While it is programmed to ignore malformed data (i.e.  
anything besides an upload of new code), it will intercept the first few bytes of data sent to the board after a  
connection is opened. If a sketch running on the board receives one-time configuration or other data when it  
first  starts,  make sure  that  the  software  with  which  it  communicates  waits  a  second after  opening the  
connection and before sending this data. 

The Mega contains a trace that can be cut to disable the auto-reset. The pads on either side of the trace can 
be soldered together to re-enable it. It's labeled "RESET-EN". You may also be able to disable the auto-reset 
by connecting a 110 ohm resistor from 5V to the reset line; see this forum thread for details. 

 

The Arduino Mega has a resettable  polyfuse that  protects  your  computer's  USB ports  from shorts  and 
overcurrent. Although most computers provide their own internal protection, the fuse provides an extra layer 
of protection. If more than 500 mA is applied to the USB port, the fuse will automatically break the connection 
until the short or overload is removed. 

The maximum length and width of the Mega PCB are 4 and 2.1 inches respectively, with the USB connector  
and power jack extending beyond the former dimension. Three screw holes allow the board to be attached to 
a surface or case. Note that the distance between digital pins 7 and 8 is 160 mil (0.16"), not an even multiple 
of the 100 mil spacing of the other pins. 

The Mega is designed to be compatible with most shields designed for the Diecimila or Duemilanove. Digital  
pins 0 to 13 (and the adjacent AREF and GND pins), analog inputs 0 to 5, the power header, and ICSP 
header are all in equivalent locations. Further the main UART (serial port) is located on the same pins (0 and  
1), as are external interrupts 0 and 1 (pins 2 and 3 respectively). SPI is available through the ICSP header on 
both the Mega and Duemilanove / Diecimila. Please note that I2C is not located on the same pins on the 
Mega (20 and 21) as the Duemilanove / Diecimila (analog inputs 4 and 5). 



Arduino can sense the environment by receiving input from a variety of sensors and can affect its 
surroundings by controlling lights, motors, and other actuators. The microcontroller on the board is 
programmed  using  the  Arduino  programming  language (based  on  Wiring)  and  the  Arduino 
development environment (based on Processing). Arduino projects can be stand-alone or they can 
communicate with software on running on a computer (e.g. Flash, Processing, MaxMSP).

Arduino is a cross-platoform program. You’ll have to follow different instructions for your personal 
OS. Check on the Arduino site for the latest instructions.  http://arduino.cc/en/Guide/HomePage

Once you have downloaded/unzipped the arduino IDE, you can  Plug the Arduino to your PC via USB cable.

Now you’re actually ready to “burn” your 
first  program on the arduino board. To 
select “blink led”, the physical translation 
of  the  well  known  programming  “hello 
world”, select

File>Sketchbook>
Arduino-0017>Examples>
Digital>Blink

Once you have your skecth you’ll 
see something very close to the 
screenshot on the right. 

In Tools>Board select MEGA

Now you have to go to
Tools>SerialPort 
and select the right serial port, the 
one arduino is attached to.





1.      Warranties 

1.1     The producer warrants that its products will conform to the Specifications. This warranty lasts for one (1) years from the date of the sale. The 
producer shall not be liable for any defects that are caused by neglect, misuse or mistreatment by the Customer, including improper installation or testing,  
or for any products that have been altered or modified in any way by a Customer. Moreover, The producer shall not be liable for any defects that result from 
Customer's design, specifications or instructions for such products. Testing and other quality control techniques are used to the extent the producer deems 
necessary.

1.2     If any  products fail to conform to the warranty set forth above, the producer's sole liability shall be to replace such products. The producer's liability 
shall be limited to products that are determined by the producer not to conform to such warranty. If the producer elects to replace such products, the 
producer shall have a reasonable time to replacements. Replaced products shall be warranted for a new full warranty period.

1.3     EXCEPT AS SET FORTH ABOVE, PRODUCTS ARE PROVIDED "AS IS" AND "WITH ALL FAULTS." THE PRODUCER DISCLAIMS ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, REGARDING PRODUCTS, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE

1.4     Customer agrees that prior to using any systems that include the producer products, Customer will test such systems and the functionality of the 
products as used in such systems. The producer may provide technical, applications or design advice, quality characterization, reliability data or other 
services. Customer acknowledges and agrees that providing these services shall not expand or otherwise alter the producer's warranties, as set forth 
above, and no additional obligations or liabilities shall arise from the producer providing such services.

1.5     The Arduino products are not authorized for use in safety-critical applications where a failure of the product would reasonably be expected to cause 
severe personal injury or death. Safety-Critical Applications include, without limitation, life support devices and systems, equipment or systems for the 
operation of nuclear facilities and weapons systems. Arduino products are neither designed nor intended for use in military or aerospace applications or 
environments and for automotive applications or environment. Customer acknowledges and agrees that any such use of Arduino products which  is solely 
at the Customer's risk, and that Customer is solely responsible for compliance with all legal and regulatory requirements in connection with such use.

1.6 Customer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory and safety-related requirements concerning its 
products and any use of Arduino products in Customer's applications, notwithstanding any applications-related information or support that may be 
provided by the producer.

2.       Indemnification

The Customer acknowledges and agrees to defend, indemnify and hold harmless the producer from and against any and all third-party losses, damages,  
liabilities and expenses it incurs to the extent directly caused by: (i) an actual breach by a Customer of the representation and warranties made under this 
terms and conditions or (ii) the gross negligence or willful misconduct by the Customer.

3.        Consequential Damages Waiver

In no event the producer shall be liable to the Customer or any third parties for any special, collateral, indirect, punitive, incidental, consequential or  
exemplary damages in connection with or arising out of the products provided hereunder, regardless of whether the producer has been advised of the 
possibility of such damages. This section will survive the termination of the warranty period.

4.      Changes to specifications

The producer  may make changes to specifications and product descriptions at any time, without notice. The Customer must not rely on the absence or 
characteristics of any features or instructions marked "reserved" or "undefined." The producer reserves these for future definition and shall have no 
responsibility whatsoever for conflicts or incompatibilities arising from future changes to them. The product information on the Web Site or Materials is 
subject to change without notice. Do not finalize a design with this information.

The producer of Arduino  has joined the Impatto Zero® 
policy of LifeGate.it. For each Arduino board produced is 
created / looked after half  squared Km of Costa Rica’s 
forest’s.



LAMPIRAN 

1.Skematik Keseluruhan 

 

 

 

 

 



 

 

 

 

 

 

 



2.  Program Pada MATLAB 

iterations = 1000; 
inertia = 1.0; 
correction_factor = 2.0; 
swarm_size = 3; 

  
% ---- initial swarm position ----- 
index = 1; 
for i = 1 : 1 
    for j = 1 : 3 
        swarm(index, 1, 1) = i * j * 10 ; 
        swarm(index, 1, 2) = j * 10; 
        index = index + 1; 
    end 
end 

  
swarm(:, 4, 1) = 1000;          % best value so far 
swarm(:, 2, :) = 0;             % initial velocity 

  
%% Iterations 
for iter = 1 : iterations 

     
    %-- evaluating position & quality --- 
    for i = 1 : swarm_size 
        swarm(i, 1, 1) = swarm(i, 1, 1) + swarm(i, 2, 1)/1.3;     %update x 

position 
        swarm(i, 1, 2) = swarm(i, 1, 2) + swarm(i, 2, 2)/1.3;     %update y 

position 
        x = swarm(i, 1, 1); 
        y = swarm(i, 1, 2); 

         
        x_sumber = 5 ; 
        y_sumber = 5; 

         
        val = (x - x_sumber)^2 + (y - y_sumber)^2;          % fitness 

evaluation (you may replace this objective function with any function 

having a global minima) 

         
        if val < swarm(i, 4, 1)                 % if new position is better 
            swarm(i, 3, 1) = swarm(i, 1, 1);    % update best x, 
            swarm(i, 3, 2) = swarm(i, 1, 2);    % best y postions 
            swarm(i, 4, 1) = val;               % and best value 
        end 
    end 

      
    %% Plotting the swarm 
    clf     
    plot(swarm(:, 1, 1), swarm(:, 1, 2), 'x')   % drawing swarm movements 
    axis([-2 30 -2 30]); 
pause(.2) 
end 

 

 



 

 

  Tech Support: services@elecfreaks.com 

Ultrasonic Ranging Module HC - SR04 

 Product features:  

Ultrasonic ranging module HC - SR04 provides 2cm - 400cm non-contact 
measurement function, the ranging accuracy can reach to 3mm. The modules 
includes ultrasonic transmitters, receiver and control circuit. The basic principle 
of work: 
(1) Using IO trigger for at least 10us high level signal, 
(2) The Module automatically sends eight 40 kHz and detect whether there is a 
pulse signal back. 
(3) IF the signal back, through high level , time of high output IO duration is 
the time from sending ultrasonic to returning. 
Test distance = (high level time×velocity of sound (340M/S) / 2, 

 Wire connecting direct as following:  

� 5V Supply 
� Trigger Pulse Input 
� Echo Pulse Output 
� 0V Ground 

Electric Parameter 

Working Voltage DC 5 V 

Working Current 15mA 

Working Frequency 40Hz 

Max Range 4m 

Min Range 2cm 

MeasuringAngle 15 degree 

Trigger Input Signal 10uS TTL pulse 

Echo Output Signal Input TTL lever signal and the range in 

proportion 

Dimension 45*20*15mm 

 



 

 

 
       Vcc  Trig  Echo  GND 
 

 

Timing diagram 

The Timing diagram is shown below. You only need to supply a short 10uS 
pulse to the trigger input to start the ranging, and then the module will send out 
an 8 cycle burst of ultrasound at 40 kHz and raise its echo. The Echo is a 
distance object that is pulse width and the range in proportion .You can 
calculate the range through the time interval between sending trigger signal and 
receiving echo signal. Formula: uS / 58 = centimeters or uS / 148 =inch; or: the 
range = high level time * velocity (340M/S) / 2; we suggest to use over 60ms 
measurement cycle, in order to prevent trigger signal to the echo signal. 

 



 

 

 Attention:  

�  The module is not suggested to connect directly to electric, if connected  
electric, the GND terminal should be connected the module first, otherwise, 
it will affect the normal work of the module. 
�  When tested objects, the range of area is n ot less than 0.5 square meters 
and the plane requests as smooth as possible, otherwise ,it will affect the 
results of measuring. 
 

www.Elecfreaks.com 



PRODUCT INFORMATION

Applications:Features:

TGS 2600 - for the detection of Air Contaminants

The figure below represents typical sensitivity characteristics, 
all data having been gathered at standard test conditions (see 
reverse side of this sheet).  The Y-axis is indicated as sensor 
resistance ratio (Rs/Ro) which is defined as follows:
	 Rs = Sensor resistance in displayed gases at 	
		  various concentrations
	 Ro = Sensor resistance in fresh air

The figure below represents typical temperature and humidity 
dependency characteristics.  Again, the Y-axis is indicated as 
sensor resistance ratio (Rs/Ro), defined as follows:
	 Rs = Sensor resistance in fresh air
		  at various temperatures/humidities
	 Ro = Sensor resistance in fresh air
		  at 20°C and 65% R.H.

* Air cleaners
* Ventilation control
* Air quality monitors

The sensing element is comprised of a metal oxide semiconductor layer 
formed on an alumina substrate of a sensing chip together with an integrated 
heater.  In the presence of a detectable gas, the sensor's conductivity increases 
depending on the gas concentration in the air.  A simple electrical circuit can 
convert the change in conductivity to an output signal which corresponds to 
the gas concentration.

The TGS 2600 has high sensitivity to low concentrations of gaseous air 
contaminants such as hydrogen and carbon monoxide which exist in cigarette 
smoke. The sensor can detect hydrogen at a level of several ppm. 

Due to miniaturization of the sensing chip, TGS 2600 requires a heater current 
of only 42mA and the device is housed in a standard TO-5 package.  

* Low power consumption
* High sensitivity to gaseous air 
         contaminants
* Long life and low cost
* Uses simple electrical circuit
* Small size

Temperature/Humidity Dependency:Sensitivity Characteristics:
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IMPORTANT NOTE: OPERATING CONDITIONS IN WHICH FIGARO SENSORS ARE USED WILL VARY WITH EACH CUSTOMER’S SPECIFIC APPLICATIONS. FIGARO STRONGLY 
RECOMMENDS CONSULTING OUR TECHNICAL STAFF BEFORE DEPLOYING FIGARO SENSORS IN YOUR APPLICATION AND, IN PARTICULAR, WHEN CUSTOMER’S TARGET 
GASES ARE NOT LISTED HEREIN. FIGARO CANNOT ASSUME ANY RESPONSIBILITY FOR ANY USE OF ITS SENSORS IN A PRODUCT OR APPLICATION FOR WHICH SENSOR HAS 
NOT BEEN SPECIFICALLY TESTED BY FIGARO.



PRODUCT INFORMATION

Model number TGS2600-B00

Sensing principle MOS type

Standard package TO-5 metal can

Target gases Air contaminants
(hydrogen, ethanol, etc.)

Typical detection range 1 ~ 30ppm of H2

Standard circuit 
conditions

Heater voltage VH 5.0±0.2V AC/DC

Circuit voltage VC 5.0±0.2V DC Ps≤15mW

Load resistance RL variable 0.45kΩ min.

Electrical 
characteristics 

under standard test 
conditions

Heater resistance RH
approx 83Ω at room temp.

(typical)

Heater current IH 42±4mA

Heater power
consumption PH 210mW VH=5.0V DC

Sensor resistance RS 10kΩ ~ 90kΩ in air

Sensitivity
(change ratio of Rs) 0.3~0.6 Rs (10ppm of H2)

Rs air

Standard test 
conditions

Test gas conditions normal air
at 20±2˚C, 65±5%RH

Circuit conditions Vc = 5.0±0.01V DC
VH = 5.0±0.05V DC

Conditioning period 
before test 7 days

ø9.2±0.2

7.8±0.5

10.0±1.0

3.6±0.1

1
23

Sensing
element

4
3.6±0.1

ø8.1±0.2

ø0.55±0.05

ø5.1

90˚ 

1.6

1.6

ø0.5 x 6
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Structure and Dimensions:

Basic Measuring Circuit:

REV: 09/13

The sensor requires two voltage inputs: 
heater voltage (VH) and circuit voltage 
(VC).  The heater voltage (VH) is applied 
to the integrated heater in order to 
maintain the sensing element at a 
specific  temperature which is optimal 
for sensing.  Circuit voltage (VC) is 
applied to allow measurement of voltage 
(VOUT) across a load resistor (RL) which 
is connected in series with the sensor.
DC voltage is required for the circuit 

voltage since the sensor has a polarity.  
A common power supply circuit can be 
used for both VC and VH to fulfill the 
sensor's electrical requirements.  The 
value of the load resistor (RL) should be 
chosen to optimize the alarm threshold 
value, keeping power consumption (PS) 
of the semiconductor below a limit of 
15mW.  Power consumption (PS) will be 
highest when the value of Rs is equal 
to RL on exposure to gas.

The value of power consumption (PS) 
can be calculated by utilizing the follow-
ing formula:

PS = 

Sensor resistance (Rs) is calculated with 
a measured value of VOUT(VRL) by using 
the following formula:

RS = (          - 1) x RL

Specifications:

Bottom view

Top view

Side view

		  VC 
		  VRL

		  (VC - VRL)2
		         RS

Pin connection:
   1: Heater
   2: Sensor electrode (-)
   3: Sensor electrode (+)
   4: Heater

All sensor characteristics shown in this brochure represent typical characteristics. Actual 
characteristics vary from sensor to sensor. The only characteristics warranted are those 
in the Specification table above. 

u/m: mm

FIGARO ENGINEERING INC.
1-5-11 Senba-nishi
Mino, Osaka  562-8505  JAPAN
Tel:  81-72-728-2561
Fax: 81-72-728-0467
email: figaro@figaro.co.jp
www.figaro.co.jp



PRODUCT INFORMATIONPRODUCT INFORMATION

Applications:Features:

TGS 2602 - for the detection of Air Contaminants

The figure below represents typical sensitivity characteristics, 
all data having been gathered at standard test conditions (see 
reverse side of this sheet).  The Y-axis is indicated as sensor 
resistance ratio (Rs/Ro) which is defined as follows:
 Rs = Sensor resistance in displayed gases at  
  various concentrations
 Ro = Sensor resistance in fresh air

The figure below represents typical temperature and humidity 
dependency characteristics.  Again, the Y-axis is indicated as 
sensor resistance ratio (Rs/Ro), defined as follows:
 Rs = Sensor resistance in fresh air
  at various temperatures/humidities
 Ro = Sensor resistance in fresh air
  at 20°C and 65% R.H.

* Air cleaners
* Ventilation control
* Air quality monitors
* VOC monitors
* Odor monitors

The sensing element is comprised of a metal oxide semiconductor layer formed 
on the alumina substrate of a sensing chip together with an integrated heater.  
In the presence of detectable gas, sensor conductivity increases depending on 
gas concentration in the air.  A simple electrical circuit can convert the change in 
conductivity to an output signal which corresponds to the gas concentration.
The TGS 2602 has high sensitivity to low concentrations of odorous gases 
such as ammonia and H2S generated from waste materials in office and home 
environments. The sensor also has high sensitivity to low concentrations of 
VOCs such as toluene emitted from wood finishing and construction products. 
Figaro also offers a microprocessor (FIC02667) which contains special software 
for handling the sensor's signal for appliance control applications.
Due to miniaturization of the sensing chip, TGS 2602 requires a heater current 
of only 42mA and the device is housed in a standard TO-5 package.  

* High sensitivity to VOCs and odorous gases
* Low power consumption
* High sensitivity to gaseous air 
         contaminants
* Long life
* Uses simple electrical circuit
* Small size

Temperature/Humidity Dependency:Sensitivity Characteristics:
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IMPORTANT NOTE: OPERATING CONDITIONS IN WHICH FIGARO SENSORS ARE USED WILL VARY WITH EACH CUSTOMER’S SPECIFIC APPLICATIONS. FIGARO STRONGLY 
RECOMMENDS CONSULTING OUR TECHNICAL STAFF BEFORE DEPLOYING FIGARO SENSORS IN YOUR APPLICATION AND, IN PARTICULAR, WHEN CUSTOMER’S TARGET 
GASES ARE NOT LISTED HEREIN. FIGARO CANNOT ASSUME ANY RESPONSIBILITY FOR ANY USE OF ITS SENSORS IN A PRODUCT OR APPLICATION FOR WHICH SENSOR HAS 
NOT BEEN SPECIFICALLY TESTED BY FIGARO.



PRODUCT INFORMATIONPRODUCT INFORMATION

Structure and Dimensions:

FIGARO USA, INC.
121 S. Wilke Rd.  Suite 300
Arlington Heights, IL  60005
Phone: (847)-832-1701
Fax:        (847)-832-1705
e-mail: figarousa@figarosensor.com

Basic Measuring Circuit:

REV: 01/05

The sensor requires two voltage inputs: 
heater voltage (VH) and circuit voltage 
(VC).  The heater voltage (VH) is applied 
to the integrated heater in order to 
maintain the sensing element at a 
specific  temperature which is optimal for 
sensing.  Circuit voltage (VC) is applied 
to allow measurement of voltage (Vout) 
across a load resistor (RL) which is 
connected in series with the sensor.
DC voltage is required for the circuit 

voltage since the sensor has a polarity.  
A common power supply circuit can be 
used for both VC and VH to fulfill the 
sensor's electrical requirements.  The 
value of the load resistor (RL) should be 
chosen to optimize the alarm threshold 
value, keeping power consumption (PS) 
of the semiconductor below a limit of 
15mW.  Power consumption (PS) will be 
highest when the value of Rs is equal 
to RL on exposure to gas.

The value of power consumption (PS) can 
be calculated by utilizing the following 
formula:

PS = 

Sensor resistance (Rs) is calculated with 
a measured value of Vout by using the 
following formula:

RS =                   - RL

Specifications:

  VC x RL

     Vout
  (VC - Vout)2
         RS
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Pin connection:
   1: Heater
   2: Sensor electrode (-)
   3: Sensor electrode (+)
   4: Heater

For information on warranty, please refer to Standard Terms and Conditions of Sale of 
Figaro USA Inc.  All sensor characteristics shown in this brochure represent typical 
characteristics. Actual characteristics vary from sensor to sensor. The only characteristics 
warranted are those in the Specification table above. 

u/m:mm



PRODUCT INFORMATION

Applications:Features:

TGS 2620 - for the detection of Solvent Vapors

The figure below represents typical sensitivity characteristics, 
all data having been gathered at standard test conditions (see 
reverse side of this sheet).  The Y-axis is indicated as sensor 
resistance ratio (Rs/Ro) which is defined as follows:
	 Rs = Sensor resistance in displayed gases at 	
			   various concentrations
	 Ro = Sensor resistance in 300ppm of ethanol

The figure below represents typical temperature and humidity 
dependency characteristics.  Again, the Y-axis is indicated as 
sensor resistance ratio (Rs/Ro), defined as follows:
	 Rs = Sensor resistance in 300ppm of ethanol
		  at various temperatures/humidities
	 Ro = Sensor resistance in 300ppm of ethanol
		  at 20°C and 65% R.H.

* Alcohol testers
* Organic vapor detectors/alarms
* Solvent detectors for factories, dry cleaners, 

and semiconductor industries

The sensing element is comprised of a metal oxide semiconductor layer 
formed on an alumina substrate of a sensing chip together with an integrated 
heater.  In the presence of a detectable gas, the sensor's conductivity increases 
depending on the gas concentration in the air.  A simple electrical circuit can 
convert the change in conductivity to an output signal which corresponds to 
the gas concentration.

The TGS 2620 has high sensitivity to the vapors of organic solvents as well 
as other volatile vapors, making it suitable for organic vapor detectors/alarms.

Due to miniaturization of the sensing chip, TGS 2620 requires a heater current 
of only 42mA and the device is housed in a standard TO-5 package.  

* Low power consumption
* High sensitivity to alcohol and organic 

solvent vapors
* Long life and low cost 
* Uses simple electrical circuit

Temperature/Humidity Dependency:Sensitivity Characteristics:
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IMPORTANT NOTE: OPERATING CONDITIONS IN WHICH FIGARO SENSORS ARE USED WILL VARY WITH EACH CUSTOMER’S SPECIFIC APPLICATIONS. FIGARO STRONGLY 
RECOMMENDS CONSULTING OUR TECHNICAL STAFF BEFORE DEPLOYING FIGARO SENSORS IN YOUR APPLICATION AND, IN PARTICULAR, WHEN CUSTOMER’S TARGET 
GASES ARE NOT LISTED HEREIN. FIGARO CANNOT ASSUME ANY RESPONSIBILITY FOR ANY USE OF ITS SENSORS IN A PRODUCT OR APPLICATION FOR WHICH SENSOR HAS 
NOT BEEN SPECIFICALLY TESTED BY FIGARO.



PRODUCT INFORMATION

Structure and Dimensions:

Basic Measuring Circuit:

REV: 08/14

The sensor requires two voltage inputs: 
heater voltage (VH) and circuit voltage 
(VC).  The heater voltage (VH) is applied 
to the integrated heater in order to 
maintain the sensing element at a 
specific  temperature which is optimal 
for sensing.  Circuit voltage (VC) is 
applied to allow measurement of voltage 
(VOUT) across a load resistor (RL) which 
is connected in series with the sensor.

A common power supply circuit can 
be used for both VC and VH to fulfill the 
sensor's electrical requirements.  The 
value of the load resistor (RL) should be 
chosen to optimize the alarm threshold 
value, keeping power consumption (PS) 
of the semiconductor below a limit of 
15mW.  Power consumption (PS) will be 
highest when the value of Rs is equal 
to RL on exposure to gas.

Specifications:

The value of power dissipation (PS) can 
be calculated by utilizing the following 
formula:

PS = 

Sensor resistance (Rs) is calculated with 
a measured value of VOUT(VRL) by using 
the following formula:

RS = (       -1)  x RL
	  	 VC

	               VRL

		  (VC - VRL)2
		         RS

Top view

Side view

Bottom view

Sensing
element

ø9.2±0.2

3.6±0.1

1
23

4 3.6±0.1

ø8.1±0.2

ø0.55±0.05

ø5.1
90˚ 

7.8±0.5

10.0±1.0

Pin connection:
   1: Heater
   2: Sensor electrode (-)
   3: Sensor electrode (+)
   4: Heater

u/m: mm

Model number TGS2620-C00

Sensing principle MOS-type

Standard package TO-5 metal can

Target gases Alcohol, Solvent apors

Typical detection range 50 ~ 5,000ppm EtOH

Standard circuit 
conditions

Heater voltage VH 5.0±0.2V AC/DC

Circuit voltage VC 5.0±0.2V DC Ps≤15mW

Load resistance RL variable 0.45kΩ min.

Electrical 
characteristics 

under standard test 
conditions

Heater resistance RH
83Ω at room temp.

(typical)

Heater current IH 42±4mA

Heater power
consumption PH 210mW (typical)

Sensor resistance RS 1kΩ ~ 5kΩ in 300ppm ethanol

Sensitivity
(change ratio of Rs)

0.3~0.5
in ethanol

Rs (300ppm)
Rs (50ppm)

Standard test 
conditions

Test gas conditions Ethanol vapor in air
at 20±2˚C, 65±5%RH

Circuit conditions Vc = 5.0±0.01V DC
VH = 5.0±0.05V DC

Conditioning period 
before test 7 days

FIGARO ENGINEERING INC.
1-5-11 Senba-nishi
Mino, Osaka  562       JAPAN
Phone: 	 (81)-727-28-2561
Fax:     	 (81)-727-28-0467
email: figaro@figaro.co.jp


